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UNDERSTANDING PHOTOSHOP
A digital image file in 
Photoshop comprises 
thousands to millions 
of small, square 
Picture Elements, 
called pixels. They 
are arranged in a 
matrix of rows and 
columns. Each pixel 
is filled with a color,  
black, white or a 

shade of gray. Each pixel exists where a row and 
column intersect, meaning it can be identified 
with horizontal and vertical coordinates. This lets 
you select pixels and edit them. Editing changes 
can be made to a single pixel, a group of pixels or 
an entire file.

What ethics should I observe?
Photoshop allows users to alter the contents 
of photographs—adding, deleting, moving 
or cloning items—in ways that are ethically 
unacceptable in journalism. However, most 
photojournalists consider it acceptable to perform 
corrections on electronic images that were 
traditionally done in wet chemistry darkrooms. 
These adjustments compensate for shortcomings 
in the chemical and material properties of 
the photographic medium—and now for its 
electronic/digital inadequacies. They restore 
the photo to what a viewer would have seen at 
the scene where it was taken. Such adjustments 
include correcting exposures of parts of, or entire, 
images, lightening and darkening selected areas, 
removing spots and scratches, and restoring color 
balance. Cropping—removing parts of an image 
around its edge—is also widely practiced.

These skills, used in all print and electronic 
publishing, can make the difference between 
a muddy image and a crisp picture that 
communicates its message clearly. 

NOTE > Not all photographs can be rescued. 
Some exposures are too far outside the 
acceptable range to be corrected. It’s much 
better to get a correct exposure while you are 
photographing.

Aesthetics of editing. Keep your changes 
subtle. They should be undetectable. Don’t overdo 
it. Don’t be obvious. Don’t try to perfect reality.

How do I control the software?
You control Photoshop through mouse clicks, 
menus, keyboard shortcuts, palettes, dialog panels 
and tools. Most of these work the same as in other 
programs. For example, under the File menu, 
the New, Open, Save As and other familiar menu 
commands perform the same functions as in all 
software. Such keyboard commands as z + c,  
z + x, z + v and z + z perform the same editing 
functions. Selecting menu items with an ellipse 
(…) opens a dialog panel. Selecting menu items 
with a triangle opens a submenu. The primary 
differences —what gives Photoshop its unique 
functionality—are found in its tools, palettes and 
dialog panels.

INTRODUCTION TO PHOTOSHOP
Photoshop lets users edit digital photographs and create original artwork, 

including type designs. In C226, we will work with a relatively small range of its functions, just 
enough for you to edit your digital photographs and prepare them for your slide show.  

If you want to learn more about this industry-standard application, consider taking  
upper-level photojournalism and graphic design electives.

This handout covers:
1) cropping
2) adjusting exposure levels
3) adjusting color balance
4) using the Burn, Dodge and Sponge tools
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Toolbox. The main section of 
the Photoshop Toolbox contains 
20 tools arranged in four groups. 
Eighteen tools have triangles 
which indicate pop-up menus 
with alternate tools, for a total of 
66 tools. To select an alternate, 
press the mouse on a tool and 
hold until the menu opens, drag 
to the desired alternate and 
release. To use a tool, click on 

it, release 
the mouse, 
drag over 
the file 
and press 
to start 

painting. 
Tools work in conjunction with 
the Options Bar, shown on Page 3 
for the Sponge Tool. The Options 
Bar lets you customize each tool’s 
functions.

Below the tools in this panel is 
the color area. Below that is an 
icon that lets you toggle between 
normal working mode and quick-

mask mode, plus screen modes.

The main tools we will use in J210 are Cropping, 
third in the left column, Dodge, seventh in the right 
column, and its alternates, Burn and Sponge.

How do I crop?
Cropping is the term for removing parts of a 
picture around its edges. In effect, it changes 
a photograph’s framing. Typically, it’s used to 
get rid of unnecessary or unwanted contents, 
especially ones that distract from the focal point. 
It’s also used to reposition the focal point within 
the frame and to call attention to a detail by 
positioning the edge of a photo near it.

To crop in Photoshop: a) Choose the 
Cropping Tool. b) Position the cursor 
towards the top left of the file, press 

down on the mouse button and drag towards the 
lower right to draw a marquee (rectangle) around 
the area of the picture you want to keep.  
c) Release the mouse. 

You don’t have to be exact on this first drag. 
Notice that everything inside the marquee is vivid, 
and everything outside appears ghosted.  
d) At the corners and sides are the editing 
handles. Adjust your crop by dragging these 
handles in or out, or rotate. e) When you have 
exactly the crop you want, tap the Return Key, 
and the pixels outside the marquee are deleted.  

If you decide you don’t want to crop, tap the 
Escape Key, which removes the crop marquee.

How do I adjust exposures?
It’s best, of course, to get a correct exposure 
when you are shooting, but Photoshop lets you 
correct images that are as much as one F-stop 
underexposed or overexposed. There are several 
ways to do this, but we’ll use two that are easy and 
effective. 

1. If your image looks too light or too dark, from 
the Image Menu > Adjustments > Levels (z+L). 
This opens the Levels panel, which shows a 
histogram in its main window.  

Histogram. Photoshop breaks the tonal scale 
into 256 values from lightest to darkest. A 
histogram is a column chart that shows how many 
pixels in the file are at each of these 256 levels. 

2. Auto. The first, and easiest step is to make 
sure the Preview button is checked then click 
the Auto button at the middle right. Photoshop 
evaluates the range of pixels in your image and 
calculates what it thinks is the ideal exposure. 
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You’ll see the histogram change. If this produces 
the desired result, click OK and save the change.

If it does not, hold down the Option key. This 
changes the Cancel button to Reset. Click Reset, 
and make manual adjustments.

Beneath the histogram are three triangles: The 
black at left controls shadows, the gray controls 
midtones and the white controls highlights.

3. Manual. In this 
example, the columns 
stop short of the left 
and right ends. That 
means the file isn’t taking 
advantage of the entire 

256-step range of the tonal scale. When you 
see a situation like this, drag the black triangle 
toward where the columns begin at the left, and 
the white triangle toward where they begin at the 
right. Also try dragging the gray triangle left or 
right. Experiment to get an intuitive feel for what 
results these triangles produce. If you don’t like 
the results, press the Option key, click the Reset 
button and try again.

Stop dragging when the exposure in the photo 
looks correct. Click OK and save.

4. Adjusting color balance. If the colors in 
your image seem out of balance, from the Image 
Menu > Adjustments > Auto Colors. Photoshop 
evaluates the colors and calculates what it thinks 
is the ideal spread. If the image does not look 
right after Auto Colors, type z + z to Undo. 
You may have to live with the incorrect color 
balance. If it’s way off, consider choosing another 
photograph or reshooting.

How do I make corrections with tools?
Palettes change the entire file or selected areas. 
Tools change only the pixels you drag them over.

1. The Dodge Tool. To lighten an 
area of the photograph, choose the 
Dodge Tool. Before you start applying 

it, choose settings in the Options Bar (above) at 
the top of your monitor: 

a. First, choose the brush size. Press on the 
triangle next to Brush and a menu opens. Drag 
the slider bar to the left to decrease the brush 
size; drag to the right to increase it. Drag the 
mouse over the file to see how large the brush is 
in relation to the image. When you get the desired 
size, click the triangle again to close the menu. 
Generally, choose a brush size about the size of 
the area you want to correct.

b. Decide if the pixels you want to correct are in 
the shadows, midtones or highlights. Choose this 
setting from the Range menu.

c. Change the Pressure setting in the Exposure 
menu from 50 percent to 10–15%. It’s better to 
make several smaller adjustments than to work at 
the default 50% and overdo your corrections.

d. Finally, hold down the mouse button and drag 
over the pixels you want to lighten. Typically with 
the Dodge Tool, you are trying to lighten skin 
tones in a face or bring out detail in the shadows. 

a.a. b. c.
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Continue working by making small drags until the 
area is lightened, but don’t overdo it. You do not 
want your editing to be noticeable. If you make a 
change that doesn’t work, type z + z to undo it. 
Or use the History Palette, discussed below, to 
return to an earlier state. Some areas may be too 
dark to correct.

2. The Burn Tool darkens pixels 
you drag it over. It works the same 
as the Dodge Tool: From the Options 

Bar, choose the Brush size, Pressure setting and 
Highlights, Midtones or Shadows. 

With the Burn Tool, you are trying to darken tonal 
areas that are so bright that they detract from the 
picture’s focal point. Again, don’t overdo it, or 
your results will look unnatural. Don’t try to turn 
a highlight into a shadow; just tone it down a bit.

3. The Sponge Tool decreases or increases the 
color saturation of the pixels you drag 
over. It works the same as the Dodge 
and Burn tools, except you choose 

Saturate, which makes the colors more vivid, 
or Desaturate, which makes them duller. In the 
Options Bar, top of Page 3, Desaturate is chosen.

How do I remove spots and scratches?
You should not encounter any spots and scratches 
on photographs made with digital cameras. But if 
you’re working with files from photographic prints 
that were scanned (digitized), you may see them. 

Choose the Stamp Tool. Choose a brush size 
relative to the spots and scratches you 
want to remove. Think about spotting 
as bad pixels that you want to replace 
with good pixels. Hold down on the 

Option key and click your cursor on some good 
pixels. Move the cursor over the bad pixels and 
paint them away. Photoshop replaces the areas 
you paint over with the pixels you’ve selected.

NOTE > The ethical standards in C226 and in 
the photojournalism profession prohibit deleting, 
adding or moving content. Use the Stamp Tool to 
correct imperfections, not to change content.

 

How do I get rid of red eye?
We strongly recommend you turn off the flash and 
shoot with available light. However, if you do use 
flash to photograph people, you will often see the 
red eye effect. It’s caused by the intense light of 
the flash reflecting off the person’s retina. 

You could use 
the Stamp 
Tool, but 
Photoshop 
makes it much 
simpler with 
the Red Eye 
Tool. 

Open the file 
and zoom in 
over the eyes. 
Press and hold on the Healing Brush Tool.  When 
its alternate tools pop open, choose the Red Eye 
Tool at the bottom of the menu. In the Options 
Palette across the top of your monitor, choose the 
Pupil Size and Darken Amount settings. Move 
your cursor over an eye and click. Photoshop finds 
all the red pixels and replaces them with pixels 
from the subject’s iris.

 
How do I turn a color photo B&W?

To turn a color 
photo into 
a black and 
white one, use 
Photoshop to 
remove all its 
saturation. From 
the Image menu 
> Adjustments > 
Hue/Saturation. 

When the panel opens, move the Saturation slider 
bar all the way to the left. The value will read -100. 
Click OK, and your photo is black and white.

  


